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FH's cresting tutorial 

i've never crested anything in my life. just a week or less ago i was posting looking for cresting help. 

the file i did find, sucked, and didn't help me in the least bit. so i rigged up my own way of cresting, that i think turned 
out okay. it's very easy, which is good. i don't know how good people would consider it, but here is the first logo i've 
ever crested:

I do think I should have made the diagonal line patterns a little more prominent, and toned down the noise just a tad. 
regardless, i think it turned out alright, and these kinds of personal judgment calls can be left up to everyone when it 
comes time for them to do their own logos. 

I'll do an Avalanche logo in this tutorial for you to see.

Let's begin!!

1. Get these logo fabric patterns (the diagonal lines) (25 degree angle | 40 degree angle | 45 degree angle | 75 
degree angle) 
I don't have them saved as patterns for you, so you're going to need to open each of them in photoshop and goto 
Edit > Define Pattern and then you'll have these 4 patterns. 

2. get your logo. while it's still large (hopefully you've gotten a logo at least 400x400 in size) use the wand tool and 
start making each color into a layer. you may want to goto chriscreamer.com and grab their avalanche logo, so you 
can follow along and get the hang of this. 10-15 minutes, i mean it.  

so, first, click on the background with the wand tool, and hit delete. 

now, deselect. i'm going to describe this as i do this avalanche logo, but you go ahead and convert it to as many 
colors as your logo will use. 

select all the maroon with the wand. to do this, click one block of maroon, then SHIFT + CLICK the second time. this 
will allow you to highlight multiple sections.  

with the maroon selected, goto Layer > New > Layer. Just name it whatever color you're doing. now select this layer 
in the Layers menu, and you SHOULD still have the maroon selected. So, eyedropper tool on the maroon, and then 
give the good ol' paintbucket to the area on the new layer.  

deselect, and continue the same procedure for each color (blue, black, grey, white.) make sure you're doing you initial 
wand selections from the original logo layer, or you're going to mess up.  

this SHOULD BE the result of step 1:
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note that, on some logos with an outline or border, you may want to make the border a separate layer than the rest 
of the color. for the ship logo up top, i did do that, for this avalanche logo, i won't be. 

2. resize to correct jersey size. this is important. figure out how big your logo is going to be on the jersey, and now 
resize this image to that size. you cannot crest and then do this AFTER, as that's going to destroy all your work. You 
need to resize first. so figure it out, and don't make it to big. for the logo of the general shape of the avs, which 
happens to be similar in rectanglular shape the the ship logo, i happen to know i want it around 210 pixels wide, so i'm 
resizing to that. (Image > Image Size)

3. Keep your original logo layer on the very bottom, but don't make it transparent. this will help with any problems 
based on the selections later. at the end you can see if making it transparent or not winds up looking better. 

Surprisingly, you're really almost done.

Time to crest this thing. 

Take a layer, I'm working with red. right click it in layers toolbox and goto blending options. 

Apply INNER SHADOW. Change blend mode to NORMAL. click blend color and simply move the mouse over the image (it 
will turn into an eyedropper tool) and select the maroon. OPACITY 100%, DISTANCE 0, CHOKE 75, SIZE 3. 

Apply INNER GLOW. Change blend mode to NORMAL. change "glow" color from that ugly off-white to BLACK. OPACITY 
27%, NOISE 0, CHOKE 67, SIZE 3.

**I typically recommend the sizes at 3 -- definitely increased them for major or big parts of the logo though. Here, I'm 
making them 4. Again, these numbers can vary by preference so you can get your own feel for things. 

Apply BEVEL AND EMBOSS. These numbers are extremely subject to personal preference, and judgment on how things 
look on the logo you're doing. However: SIZE 10, SOFTEN 16, DEPTH 120, OPACITY WHITE 38, OPACITY BLACK 42. 
Apply the CONTOUR sub-heading. RANGE 50. I recommend unchecking "use global light" and then moving the light 
source to wherever you like the look. 

One left! Apply PATTERN OVERLAY. This is the main focus color of the logo, so I typically use the 40 or 45 degree 
pattern here. So apply that patter, and you're going to get a ton of white and black lines across the logo -- set the 
opacity around 7 and things will be much better. 

Now, I'm done with the red. Looking at it, I decide that the INNER GLOW for such a dark color should be white, not 
black. for many other colors (every color on the SHIP LOGO) I used black. so, I go back and make the INNER GLOW to 
WHITE, and change the opacity to 22. Learn to gauge these things.  

Now, Add Noise to the layer.  Filter > Noise > Add Noise I like a Gaussian, at 3.5%.  

Here's how the red looks after these few steps: 
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Next I hit up the white. I changed a few numbers, and used a different directional pattern. ADDITIONALLY, I used 
BLACK for the inner glow on white, NOT WHITE, like i had on the dark color. here's the result:

I ran down and did the same to all the remaining layers, changing a thing here or there, and here's my final product:

Not bad, for my second crest ever. 

Hopefully this is helpful to anyone else who's like me and looking for something as a base to work from.  

NOTE: since the grey is so thin, i did nothing but apply a layer of noise (10% or so, gaussian) to it. when you have a 
big area of one color (the avs logo doesn't have it, but the ship logo i posted does) you may want to play around with 
the "satin" overlay to get a little more depth to the logo.  

EDIT: Joe told me it looked like too much bevel on the red, so i toned it down some. you may or may not find it as an 
improvement, i certainly do.  

 
__________________
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Cheezymadman  
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Uploads: 2

  

When you're making a new layer, you don't have to make a new layer, then paintbucket. You can just 
select the maroon, right click, and Layer via Cut. 

    

 02-13-2008, 03:37 PM   #3 

fireholder  
Senior Member
 
Join Date: Jan 2008
Posts: 149 
Downloads: 45
Uploads: 1

Quote:

that works too, then. either way, people know how to do it.  i just got photoshop like 3 weeks ago. 
  

__________________

 

Originally Posted by Cheezymadman   

When you're making a new layer, you don't have to make a new layer, then paintbucket. You 
can just select the maroon, right click, and Layer via Cut.

    

 02-13-2008, 03:59 PM   #4 

The Nemesis  
Displaced Sharks Fan
 

  
 
Join Date: Feb 2008
Location: Langley, B.C.
Posts: 87 
Downloads: 20
Uploads: 2

Quote:

Personally, I prefer to use Layer Via Copy because it keeps the original logo intact in case you need to 
get the color layer again, or sometimes because edges with blended colors don't get picked up with 
the magic wand (especially if you've played with the tolerance levels)

Also, I would recommend that for step 1 you copy the complete logo image to a new photoshop image 
file (ctrl+A, +C, +N, +V in that order). Sometimes some image formats don't let you remove the 
background to transparency (particularly jpgs) 
__________________

 

Originally Posted by Cheezymadman   

When you're making a new layer, you don't have to make a new layer, then paintbucket. You 
can just select the maroon, right click, and Layer via Cut.
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Cheezymadman  
Senior Member
 

  
 
Join Date: Feb 2008
Posts: 341 
Downloads: 131
Uploads: 2

  

Quote:

that's when i just duplicate the layer and delete the old BG layer 

Originally Posted by The Nemesis   

Also, I would recommend that for step 1 you copy the complete logo image to a new 
photoshop image file (ctrl+A, +C, +N, +V in that order). Sometimes some image formats don't 
let you remove the background to transparency (particularly jpgs)
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fireholder  
Senior Member
 
Join Date: Jan 2008
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Downloads: 45
Uploads: 1

enough photoshop jargon, is it a good tut or not, lol   

__________________
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Karl  
Phoenix Down'd Addonist
 

  
 
Join Date: Feb 2008
Location: Longueuil,QC
Posts: 385 
Downloads: 40
Uploads: 7

  

not because you use Bevel & Emboss   

__________________
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Doran  
Senior Member
 

  
 
Join Date: Feb 2008
Location: Hamilton, Ontario, 
CANADA
Posts: 128 
Downloads: 18
Uploads: 1

  

Not bad, not bad. I like the inner glow. Really makes it real looking. I might add that to my own 
cresting technique.

(I add Noise, of about 7-8%, to every colour. Except for gold or silver. I add about 10-12% for them.)  
__________________

Come check out my Jersey Pack! Complete history of jerseys for EVERY NHL team! Click HERE!  
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Rebel  
Junior Member
 
Join Date: Feb 2008
Posts: 1 
Downloads: 23
Uploads: 0

Quote:

Shut up bitch. 

Originally Posted by Karl   

not because you use Bevel & Emboss  
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Karl  
Phoenix Down'd Addonist
 

Quote:

Originally Posted by Rebel   
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Downloads: 40
Uploads: 7

  

what the ***** Pete?  

 

__________________

 

Shut up bitch.
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Cheezymadman  
Senior Member
 

  
 
Join Date: Feb 2008
Posts: 341 
Downloads: 131
Uploads: 2

  

How do you do cresting of solid color flat areas, like those bars in your sig? 
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Drezz  
Ol' Skool
 

  
 
Join Date: Dec 2007
Posts: 436 
Downloads: 197
Uploads: 66

On your Inner Glow, I'd recommend using a Color Dodge to lighten the surrounding colour first. Convert 
that effect to a layer then apply your white inner glow at a reduced opacity and lay that overtop your 
other effects for a more realistic looking highlight. 
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quattre777  
Member? Of What?
 

  
 
Join Date: Feb 2008
Location: Toronto, Ontario, 
Canada
Posts: 93 
Downloads: 412
Uploads: 2

Nice tutorial. I totally suck a cresting, so this really helped. Thanks. 
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fireholder  
Senior Member
 
Join Date: Jan 2008
Posts: 149 
Downloads: 45
Uploads: 1

Quote:

 good 

 

__________________

Originally Posted by quattre777   

Nice tutorial. I totally suck a cresting, so this really helped. Thanks.
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Burk  
Member
 

  
 
Join Date: Feb 2008
Posts: 96 
Downloads: 120
Uploads: 0

I do my cresting sort of similar so this is something I can somewhat understand.

Good tut. 
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Tinke  
Mask Shinerer
 
Join Date: Feb 2008
Location: Kiuruvesi, FINLAND
Posts: 185 
Downloads: 24
Uploads: 7

  

could someone do it for psp too? 
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Drumhellion  
Junior Member
 

  
 
Join Date: Feb 2008
Location: York, Yorkshire, 
England
Posts: 8 
Downloads: 16
Uploads: 0

Well I had a minute whilst I was waiting for someone so I thought I would give this a go. It was fairly 
clearly written unlike a lot of other cresting tutorials I have seen so I thought why not. I followed the 
directions and tweaked a few things (mainly the bevel and emboss which I wasn't keen on) and I think 
I got a pretty good result. Below is what I came up with (two Oilers logos I modified). I don't think 
they are half bad for my first try, tell me what you think. If you think they are good then all credit 
goes to fireholder for the great tutorial! Thanks fireholder!

 
__________________
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Cheezymadman  
Senior Member
 

That second logo is hideous, but I guess that's not your fault.   
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Join Date: Feb 2008
Posts: 341 
Downloads: 131
Uploads: 2
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l.h.  
Add-On Artist 
 

  
 
Join Date: Feb 2008
Posts: 832 
Downloads: 306
Uploads: 3

Quote:

Drezz knows what he ist talking about

 

One other tip to add realism is to start using the dodge and burn tools on different modes to achieve 
desired shading effects. I can be tricky at first but it helps you from being lazy and just using pre made 
effects which suck terribly. 
__________________

Project progress

Jerseys DONE
Letters DONE
Numbers DONE
Ice DONE
Boards DONE
Masks 38/97
Arenas 4/30 

Originally Posted by Drezz   

On your Inner Glow, I'd recommend using a Color Dodge to lighten the surrounding colour 
first. Convert that effect to a layer then apply your white inner glow at a reduced opacity 
and lay that overtop your other effects for a more realistic looking highlight.
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fireholder  
Senior Member
 
Join Date: Jan 2008
Posts: 149 
Downloads: 45
Uploads: 1

Quote:

 

lookin' pretty good to me.  i'm glad it's easy to follow.   
__________________

Originally Posted by Drumhellion   

Well I had a minute whilst I was waiting for someone so I thought I would give this a go. It 
was fairly clearly written unlike a lot of other cresting tutorials I have seen so I thought why 
not. I followed the directions and tweaked a few things (mainly the bevel and emboss which I 
wasn't keen on) and I think I got a pretty good result. Below is what I came up with (two 
Oilers logos I modified). I don't think they are half bad for my first try, tell me what you think. 
If you think they are good then all credit goes to fireholder for the great tutorial! Thanks 
fireholder!
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 04-18-2008, 07:57 PM   #21 

jp_0988jp  
Member
 
Join Date: Mar 2008
Posts: 30 
Downloads: 36
Uploads: 0

When I check to pattern box in the blending options, the pattern does not appear?? Any idea why?? 

    

 04-18-2008, 08:45 PM   #22 

DucksFan  
Travis Moen?
 

  
 
Join Date: Feb 2008
Posts: 738 
Downloads: 218
Uploads: 10

I'm going to be completley honest. Lose the bevel and embossing. Dodge and burn instead. Bevel and 
Emboss kills it. 
__________________
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